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Introduction

Soundtrack Pro is an audio editing program designed to work in concert with the Final Cut Pro video editing
program.

It can be used for more fine tuning of audio tracks in your video files than is possible in Final Cut Pro.

It also can be used to edit audio files that are not attached to video, such as audio you recorded on a compact
flash recorder or a minidisc recorder.

NOTE: This tutorial has been updated for Soundtrack Pro 2, which has some differences from previous
versions of Soundtrack Pro.
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Starting a Project

Open Soundtrack Pro from the Applications area in Apple's Finder Window.

The screen setup should look like this:

If for some reason your screen has a different layout or appearance, press the F1 key to return to a normal
view.

There are several different components to the Soundtrack Pro layout.

Video viewer/Project info - This area will allow you to see video content and project information.• 
Main project window - This is the main work area for your project; allowing you to either work on
single files or in several tracks in multitrack mode.

• 

Recording levels and audio meters - This area will allow you see the recording and playback level
meters.

• 

Show/Hide Window Panes - Allows you to hide various window panes to increase your project area.• 
Browser/Search - the area on the right toward the bottom where you can see all your source media,
including audio files that are on your computer. This will only show folders and compatible audio
files.

• 

Control bar - This is the main control bar where you can initiate recording, playback and other
functions.

• 

Mixer pane - This area has several tabs including a mixer for use during multitrack editing.• 
Utility Window - the area on the left at the bottom where you monitor audio record levels, as well as
video tracks associated with your audio. This is also where you find the actions window pane.

• 
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Importing Files from a Compact Flash Audio Recorder

If you recorded your audio on a Compact Flash Audio Recorder, you can easily open the audio files in
Soundtrack Pro.

First you need to move the audio files from the audio recorder's compact flash card onto your computer, using
either a USB cable or a card reader attached to your computer. See the section of the tutorial for Compact
Flash Audio Recorders on Downloading Audio to a Computer.

Transfer from the compact flash recorder only the audio segments you need for your project. Don't import an
entire recorded session from your recorder. it will much easier to keep track of your media and put together
your project if you transfer only the audio segments you think you might use.

We recommend saving all the audio files you plan to use in a folder labeled Audio on your computer or on an
external firewire drive. It is important to save sound files in the same file folder so you and Soundtrack Pro
can better keep track of them.

Once you've transferred audio files from a compact flash recorder, you'll be able to access them in Soundtrack
Pro's Browser Window on the left by selecting the Home Icon toward the top right.

You then can select the folders and subfolders in the Browser to navigate to your audio files (such as in the
Audio folder on your computer or external firewire drive).

You can audition your audio files by clicking on the file name.

To stop playing an audio file, click on the Play/Pause button on the lower left of the Browser window.

Note: The next sections of this tutorial are about importing audio from a minidisc recorder. If you're only
using a compact flash audio recorder, you can skip ahead to the section on Editing Waveforms in Soundtrack
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Pro

 Soundtrack Pro

Importing Files from a Compact Flash Audio Recorder 4



Importing Audio from a Minidisc Recorder

To import audio into Soundtrack Pro from a minidisc recorder, first turn on your minidisc recorder in
playback mode.

Then set the headphones audio level to its maximum (we'll use Soundtrack Pro or the Mac computer to set the
audio input levels later).

Plug one end of a 1/8th inch mini-to-mini cable into the audio input jack on the computer. Plug the other end
of the cable into the headphone jack of the minidisc player.

On your Mac computer, click on the Apple Menu icon at the very top left, and select System Preferences in
the menu.

In the System Preferences menu, click on the Sound Icon:

Click on the Input tab at the top and make sure Line In...Audio Line-in port is chosen.
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Below move the Output volume slider all the way to the right (the maximum setting). Make sure the Mute
box is not checked.

Now you can use the Input volume slider to adjust the volume level of the audio you want to import from the
minidisc player to the computer.

To do this, press play on the mindisc recorder. Then use the Input volume slider to adjust the audio levels,
which are displayed on the Input level meter.

Make sure the loudest audio in your recorded audio segment registers no more than three bars in from the far
right of the Input level meter. This will avoid distortion of the audio when you import it into your computer.

Once you've adjusted your audio, return to Soundtrack Pro to start the importing process.

 Soundtrack Pro

Importing Audio from a Minidisc Recorder 6

http://multimedia.journalism.berkeley.edu:80/tutorials/audio/soundtrackpro/printfriendly/../../../../tutorials/audio/minidisc/playback


Importing from a Minidisc Recorder - Record Setup

In Soundtrack Pro, click on the New Audio File icon at the top of the Project Window toolbar:

You will get this prompt:

Choose Mono and 4800 Hz Sample Rate and click on OK.

Your screen now should look something like this:

In the Utility Window at the upper right, click on the Recording tab.

Set the Input selection to either Built-in Microphone for the microphone built into the computer, or Built-in
Input if you are using an external microphone.

(In order to listen to your audio as it is being recorded, you must plug in earphones and change the Monitor
setting to built-in output)
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Here you can view the input levels of your audio in the vertical meter on the left, and you can adjust the input
volume of your audio using the Gain slider to the right. Use the Gain slider to adjust the input level so the
loudest audio is in the minus zone on the meter.

Note: on some Mac computers, the built-in sound card does not support adjusting the audio input levels in
Soundtrack Pro, and you'll see the Gain slider grayed out. In this case, you can adjust the audio levels of the
sound in one of three ways:

By adjusting the input levels using the Sound selection in Apple's System Preferences menu, as
shown in the previous step.

1. 

By adjusting the output volume control (headphone volume) on the minidisc recorder or other device.2. 
By adjusting audio levels in Soundtrack Pro after importing the audio.3. 

Also note that on Mac computers with this problem, you can bypass the issue by importing audio through a
USB break-out device such as a Griffin iMic or Digidesign M-Box. The Soundtrack Pro input gain slider will
always be available when using USB audio input.

Now queue your minidisc player to the audio segment that you want to import and press pause on the minidisc
recorder.

 Soundtrack Pro
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Importing from a Minidisc Recorder - Recording

To start the process of recording your audio from a minidisc recorder onto the computer, press the Record
button on the bottom of the main Projects Window.

Then press play on the minidisc recorder.

The Projects Window screen should now look something like this, with a red field running through the
timeline:

Stop recording by pressing the space bar on your computer.

Then pause the minidisc recorder.

Next you'll need to name and save onto your hard drive the audio file you just recorded.

 Soundtrack Pro

Importing from a Minidisc Recorder - Recording 9

http://multimedia.journalism.berkeley.edu:80/tutorials/audio/soundtrackpro/printfriendly/../../../../tutorials/audio/minidisc/playback
http://multimedia.journalism.berkeley.edu:80/tutorials/audio/soundtrackpro/printfriendly/../../../../tutorials/audio/minidisc/playback#pausing


Importing from a Minidisc Recorder - Saving Files

After importing an audio segment from a minidisc recorder using Soundtrack Pro, you need to save the audio
file on your computer.

Go to the File Menu at the top left and choose Save As.

Name the audio file in the Save As field.

In the Where field, navigate to the folder where you want to save the audio file (we recommend saving the
audio files in an Audio folder on your computer or on an external firewire drive).

Finally, click on the Save button at the lower right.

Repeat the previous steps on recording to import from a minidisc recorder the rest of the different sound files
you want to use in your audio project.

Save the new audio files in the same folder as your original one. It is very important to save sound files in the
same file folder so you and Soundtrack Pro can better keep track of them.

Import from the minidisc recorder only the audio segments you need for your project. Don't import just an
entire recorded session from your recorder. it will much easier to keep track of your media and put together
your project if you transfer only the audio segments you think you might use.

Once you've imported your audio files, you'll be able to access them in Soundtrack Pro's Browser Window
on the left by selecting the Home Icon toward the top right.
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You then can select the folders and subfolders in the Browser to navigate to your audio files (such as in the
Audio folder on your computer or external firewire drive).

You can audition your audio files by clicking on the file name.

To stop playing an audio file, click on the Play/Pause button on the lower left of the Browser window.
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Editing a Sound Clip in the Waveform Editor

As a first step in audio editing in Soundtrack Pro, you should clean up your individual audio files using the
Waveform Editor.

The Waveform Editor allows you to do very fine edits of a single audio file, such as cutting out small
imperfections or other unwanted segments that you can see more clearly in a waveform view of the audio file.

After you're done cleaning up your individual audio files in the Waveform Editor, then you can place them in
the multi-track area to the right and beginning editing your final audio sequence.

At the new screen give a name to your file (such as the name of the original file followed by edited) and save
it in the same folder as all your other audio files.

The audio file then will appear in its own window, where you can edit the sound wave for the audio.

Play the audio file by pressing the space bar on your computer.

You can zoom in on the waveform by holding down the Apple key and then pressing the + key.

You can zoom out by holding down the Apple key and then pressing the - key.

Marking Clip Segments in the Waveform Editor

In the waveform editor, you also can add markers at precise locations in your audio clip. Then you can cut out
any unwanted segments of your audio between the markers.

You add a marker to the waveform by moving the playhead to the place where you want the marker to appear
and pressing M on your keyboard.
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A green marker that looks like a tiny upside-down house will appear exactly where the playhead is located.

If you want to specify a more exact placement of your marker, you can click on the time code and type in a
specific time. Your playhead will automatically move to that point and you can press M to set a marker. You
can also grab and drag a marker to a new point in your timeline.

Next, add another marker using the same procedure.

To eliminate an audio segment between two markers, double click on the audio waveform anywhere between
the two markers to highlight the segment.

Then click on the delete key on your keyboard to remove the segment.
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Creating a Multitrack Project

After importing audio flles you can create a project, which will have multiple tracks on a timeline on which
you can arrange your individual audio files.

To do so click on the New Project icon:

Now, save the new project, by clicking at the top on File...Save As.

Save and name the project in the same folder where you imported your audio files (such as in the
Source/Audio folders on your external firewire drive).

Notice the difference between the tabs for a project and for audio files at the top of the Project Window.

The sound files have a small wave file icon to the left of their names.

The multitrack project files look like stacked multiple tracks.

You can toggle between the individual audio files and your project, by clicking on the tabs.
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Editing Audio in the Multitrack

After you've cleaned up your individual audio files in the Waveform Editor, you can bring them into the
multitrack to begin assembling your audio piece.

To do this, select the tab for your project in the Project Window to the right. Then click on an audio file in
the Browser Window, hold down your mouse button and drag the file to one of the tracks in the Timeline of
the Project Window to the right.

Repeat the process to bring other audio files into the Timeline, either before or after an existing audio file on
the same track, or onto a new track. You might want to put a music audio file on a separate track if the music
is going to play in the background while another audio file, such as someone speaking, is playing.

Once an audio file is in the Timeline, to play the audio file move the playhead above the track to the
beginning of the file and press the space bar on your computer to start playing it.

To pause play, press the spacebar again.

Understanding a Track in the Multitrack View

To the left of each track are some buttons and other controls for changing the settings for the audio on each
track.

Rename the track by clicking on it. This helps to identify each track.• 
Bypass effects button will turn off any real-time effect that were added so you can hear the audio
only.

• 

Arm this track for recording will set this track for recording, so that when you hit the record button
this track will capture the audio.

• 

Mute button will mute the audio on a particular track in your project.• 
Solo button will let you listen to only the audio on a particular track in your project. (shuts off other
tracks)

• 

Volume Control slider lets you increase or decrease the volume of all the audio files on a particular
track.

• 

The Pan Control slider lets you change how much of the sound will be sent to the right channel or
the left channel (such as t right and left stereo speakers).

• 

Adjusting the Pan and Volume controls will affect the audio on all the clips on a track.

(if you want to change the volume or the panning in select portions of a clip on a track, go to next section of
this tutorial on Editing Sound Envelopes).
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In an audio track you can trim the length of a clip. Or you can cut a clip in two, which then allows you to
move or discard one of the new segments.

Trim: To trim a clip, move your mouse cursor to the edge of an audio clip, and a bracket that looks
like a staple with a left and right arrow will appear. Click and drag the edge of the clip to the point
you want to trim the clip.

• 

Cut: To cut or razor a clip, first select the razor tool in the top left corner of the Project Window.
Then move your mouse cursor over the audio clip and press the mouse button at the point where you
want to separate the clip.

• 

You then need to select the arrow tool at the top left of the Project Window and click on one of the segments
of the audio clip, to move it or delete it (by pressing the delete key on your keyboard).

Note: the blade tool in Soundtrack Pro is similar to the one in Final Cut Pro. You can select the blade tool in
both programs by pressing the letter B on your computer keyboard. To return to the normal arrow tool, press
the letter A on your keyboard.

Marking Sequences in the Multitrack

In the multitrack view you can add markers at precise locations in your audio sequence.

You add a marker to the sequence by moving the playhead to the place where you want the marker to appear
and pressing M on your keyboard.

A green marker that looks like a tiny upside-down house will appear exactly where the playhead is located.

You can move markers in the sequence, but clicking and holding on the green triangle and dragging the
mouse back and forth.

You can also specify a specific time for a marker by clicking on the time code at the top, and typing in a time
then setting the marker where the play head moves. 
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To delete a marker, click once on the green triangle and click on the delete key on your keyboard.
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Using automatic fades

The new version of Sountrack Pro 2 includes some new features for doing automatic fades which are easy and
quick.

Automatic fades are only possible in the multitrack mode.

While working in the multitrack mode with an audio track open, move the selector cursor arrow to the upper
left corner of the track. (You might notice a small envelope icon appear below the arrow). Click down and
drag the arrow to reveal a fade function.

Once you drag the fade, you can double-click the fade portion of your audio track to reveal a fade HUD,
which allows you to chose among several simple fade types.

This will allow you to select among four simple fade types.

Making fades is also possible at the end of audio tracks to fade sound out. These are quick-and-easy ways to
make fades without having to adjust a sound envelope, which has several benefits over this method, but is
more complicated and is more time intensive.
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You can also cross-fade two separate audio tracks so that the sound fades in on one track while the the sound
fades out on the other. To do this, you must set the Cross-Fade for Overlapping Tracks setting.

If you don't set this, then by overlapping track, you will be essentially overwriting tracks. This is called
truncating the tracks.

Once you are sure that you have the cross-fade setting turned on (it's on by default), then you can drag one
track on top of another. At the part where they overlap, Soundtrack Pro will automatically create a crossfade.

Likewise, you can double-click on the crossfade to bring up a dialog box that will allow you to choose the
type of fade for each side of the audio.

How does this method differ from setting the sound envelope method?

Using automatic faders built into the new version of Soundtrack Pro 2:

Easy• 
Quick• 
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Neat-looking HUD• 
Not much control of the curve other than presets.• 
Can only fade in-or-out on the ends of tracks, not in the middle of a track.• 

Using the sound envelope method to control the sound across an audio track:

Slightly more difficult (several steps involved)• 
More time consuming, you have to listen to the changes each time.• 
Much more control over the way the sound fades in-and-out.• 
You can adjust the sound across the entire track, not just at the ends.• 
You can fade the sound to low without turning it off.• 
You can make changes in the middle of the track.• 
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Editing Sound Envelopes in the Multitrack

Sound envelopes allow you to manipulate the audio levels at different points in an audio track, such as
creating a fade in or a fade out in an audio clip.

You have to be in the multitrack view to manipulate sound envelopes.

To display a sound envelope, look to the far left of an audio track for the name of the track. Next to the track
name you'll see a tiny triangle.

Click on the tiny triangle next to the track icon and the Sound Envelope will appear under the audio track.

The Sound Envelope has two purple tracks.

One is for adjusting Volume, the other is for adjusting Panning.

In the volume envelope, the horizontal black line that runs through the middle of the track represents the audio
level for that track.

If, at the very beginning of the track, you click on the triangle at the start of the horizontal line, you'll be able
to use the triangle to move the volume up or down for all the audio on that track.

If you want to increase or decrease the volume only in certain parts of a clip, move the cursor along the
volume line to the point where you want to change the volume. Double click on that point.

A tiny diamond should appear on the black horizontal line.

Move to the next point where you want to change the volume and double click again. Another tiny diamond
will appear.

Now click once on one of the diamonds and drag it up or down to adjust the audio volume.

Use the same procedure to create more diamonds to adjust the volume up or down in other portions of the
clip.

To remove one of the diamonds, click on it once and press the delete key on your keyboard.

Use the same procedure to adjust the Panning, by creating triangles on the horizontal line to move the audio
up or down and shift the volume to the left or right channels.
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Shortcut Keys

Here are some quick keys that we recommend to help you improve your
work flow with Soundtrack Pro.

General shortcut keys to use in Soundtrack Pro 

Space Bar = makes playhead play
Return = brings playhead to beginning of file/project
Shift+Return = brings playhead to beginning and starts playing
Option-Right/Left Arrow = Moves the playhead forward or backward by one frame

L = To begin forward playback at normal (1x) speed
J = To begin reverse playback at normal (1x) speed
K = To pause playback
JJ or LL = To double the current playback speed, forward or reverse
To move the playhead at below 1/2x speed hold down the K key, then press and hold down J or L

Layouts:

Control A = Show/Hide Left Pane
Control S = Show/Hide Lower Pane
Control D = Show/Hide Right Pane

Navigation:

Apple + = Zoom In horizontally
Apple - = Zoom Out horizontally
Apple Shift + = Zoom In vertically
Apple Shift - = Zoom In vertically
Shift Z = view the entrie file or project in the editing window
N = Snaping off and on
M = Make a marker
Shift M = moves playhead to next marker
Option M = moves playhead to previous marker

Quick Keys for Multitrack Projects ONLY:

B = Razor Blade Tool
A = Arrow or Selector Tool
S = Split a track in two
Option S = Join two split track back together
E = To show/hide envelopes for specific tracks
Up Arrow = takes playhead to start of next clip in timeline
Down Arrow = takes playhead to end of previous clip in timeline

If your project looks like the following:
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it's because your vertical adjustment is off.

Use the Apple (Ctrl on a PC) Shift and + or - keys to adjust the vertical height of your waveform.

These views can be also found under the VIEW menu at the top of the screen. 
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Editing Final Cut Pro Audio Files

You can export a single audio file from a Final Cut Pro video project to Soundtrack Pro for precise editing of
audio files. Or you can export a multitrack file of audio and video from Final Cut Pro to Soundtrack Pro for
audio editing.

If you work with a single audio file in Soundtrack Pro, when you save all your changes they will
simultaneously be changed in Final Cut Pro.

If you export a multitrack project, you will have to re-import a mixed down file into Final Cut Pro, and you
then won't have individual audio tracks to work with in Final Cut Pro. So you should finish editing the video
before exporting and editing a multitrack audio project in Soundtrack Pro.

Exporting a Single Audio File into Soundtrack Pro

1. In Final Cut Pro, find the audio file in the sequence window you would like to edit in Soundtrack Pro. Click
on it once to highlight it.

2. Next press and hold down the CTL key on your keyboard and click again on the file.

3. A menu will appear. Choose Send To, and then Soundtrack Pro Audio File Project.

4. Soundtrack Pro will open and you will be able to edit your audio clips. When you save in Soundtrack Pro,
the changes will be reflected in the Final Cut Pro audio file in the sequence.

Exporting a Multitrack Project into Soundtrack Pro

1. In Final Cut Pro, double click in the browser on the sequence you want to edit. Then press and hold down
the Apple key on your keyboard and press the A key to highlight your entire video sequence.
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2. Next press and hold down the CTL key on your keyboard and click again on one of the audio files in the
sequence.

3. A menu will appear. Choose Send To, and then Soundtrack Pro Multitrack Project.

4. Soundtrack Pro will open and the multitrack project will appear. You can edit your audio, but the changes
will NOT be reflected in the Final Cut Pro sequence.

5. When you are done editing, export the mix by going to Soundtrack Pro's File menu, and choosing Export
and Export Mix. Select a name and a folder for the mixed audio file.

6. Open up Final Cut Pro and in the File menu choose Import.
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7. Navigate to the audio mix you exported from Soundtrack Pro and it then will appear in Final Cut Pro's
Browser.

8. Click and drag the audio mix into a new audio track on the Timeline for your sequence. Drag the file to the
very beginning of the Timeline.

You then can either delete or mute the other old audio tracks.
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Exporting A Sequence

When you are satisfied with the editing of your audio project, you need to export your mix to the correct audio
format for the given destination.

Audio Format Types: 

Waveform Audio Format (WAV) - This is an uncompressed audio format developed by Microsoft and IBM.
It is generally used for professional audio applications. Since it is uncompressed, it generally makes a very
large file size and is typically not suitable for the Web.

Audio Interchange File Format (AIFF) - This is an uncompressed audio format co-developed by Apple in
1988. It is generally used for professional audio applications. Since it is uncompressed, it generally makes a
very large file size and is typically not suitable for the Web.

Advanced Audio Coding (AAC, .M4A, .M4B, .3GP, .MP4) - This is a compressed audio format that works
much like the MP3 format. It is well known due in part because it is the format of all iTunes music and
podcasts. Most mobile players like iPods, iPhones, Zunes, Zens and PSPs are capable of playing AAC files
types. Web browsers can play AAC with help from plugin players like Apple's QuickTime.

MPEG-1 Audio Layer 3 (MP3) - This is a compressed audio format that gained enormous momentum in the
late 90s from peer-sharing services like Napster. It is by far the most ubiquitous audio format. Because it is
compressed, it has the potential to experience sound quality degradation if re-encoded. (i.e. re-editing an MP3
that has already been compressed)

While AAC is gaining lots of momentum in the industry, and is expected to replace the MP3 format, for now
the ubiquity and acceptable quality of the MP3 format makes it a good choice for multimedia. For now, this
tutorial will focus on exporting audio to MP3.

Exporting MP3 using Soundtrack Pro 2

Note: mp3 export is only available with Soundtrack Pro 2. 

Go to the File menu and choose Export.
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Choose MP3 File for the File Type, 128 kbps (or more) for the Bit Rate, and 44.1 kHz (or 48 kHz) for the
Sample Rate. If you have stereo audio, you should chose the Stereo option under channels, otherwise choose
mono. Mono is recommended for multimedia production since it produces smaller files, and only requires one
microphone when recording.

NOTE: If you want to use the audio in a Flash project, you should pick AIFF, since this file type can be
imported directly into Flash. This way Flash will not re-encode an existing compressed mp3 file. 
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Pick a folder for the file (such as the Audio folder on your computer or external firewire drive), and click on
the Export button. Your audio project will be mixed into a new, single MP3 file.

Generating Compressed QuickTime Audio for the Web

MP3s will work on most Web browsers, but they do so by opening up a browser plug-in that can vary from
computer to computer. You have the option to utilize a particular player for better control over the user
experience. QuickTime is one such player that can easily integrate into Web pages.

The QuickTime player becomes QuickTime Pro when you register (pay for) the product. This gives
QuickTime Player the ability to transcode between dozens of media formats.

Launch QuickTime Pro and click on File...Open. Navigate to the folder where you have the AIFF file you
exported from Soundtrack Pro, select the file and and click OK. Your AIFF file will load into QuickTime.

Now click on File...Export and pick a folder for your final compressed .mov QuickTime audio file. Change
the output filename if you like (being sure to keep the .mov extension).

At the bottom of the file panel in the Export section, select Movie to QuickTime Movie from the picklist,
then click the Options button.

The Video section of the next panel will be dimmed out.

In the Sound section, click the Settings button and select:
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Format:AAC
Channels:Mono
Rate:44.100

The panel should now look like this:

Click OK. The QuickTime export panel should now look like this:
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Be sure to enable Prepare for Internet Streaming and select Fast Start as the streaming type (unless your
audio will live on a QuickTime Streaming Server rather than a regular Web server, in which case you should
selected Hinted Streaming)

Click OK and the compression process will begin. This may take a few seconds or much longer, depending on
the length of your audio file.

When compression has finished, compare the file size of the original AIFF to the file size of the exported
.mov audio file.

Then compare the audio quality of both by double-clicking them and listening to them carefully in an audio
player.

If you're not satisfied with the sound quality, experiment with other options in the Settings for the Sound
panel described above (we've found these settings very satisfactory for general purposes).

If you now want to embed the QuickTime audio in a Web page, go to the tutorial on Adding Multimedia
Elements to Web Pages.
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Burning Audio and Data CDs

Before burning a CD, think carefully about whether you want to burn an audio or a data CD.

Burn an audio CD when you want a CD that can be played in any standard audio CD player, such as the one
in your home or car stereo system, or in a "boombox."

Burn a data CD when you want to store or transfer audio files that can be opened on a computer, moved to
another computer, or worked on in an audio-editing application.

These instructions pertain to burning CDs with tools that are built into Mac OS X. Windows or Linux users
will need to obtain separate audio and data CD burning software.

To Burn an Audio CD

To create an audio CD that can be played in any standard audio CD player:

1) Export your tracks from Soundtrack Pro as STP, AIFF, or WAV files . Save them to a folder in a known
location, such as the Desktop.

2) Launch iTunes from the Dock (if not on the Dock, you'll find it in the Applications folder on your hard
drive).

3) Click the "+" icon on the lower left side of iTunes to create a new playlist. Name the playlist whatever you
like.

4) Drag your AIFF or WAV files into the playlist. Drag files up or down in the playlist to change their order.
If necessary, adjust track volume or start and stop times by selecting a track and hitting Cmd-I (for Get Info),
then selecting the Options tab.

5) Insert a blank CD

6) Make sure the playlist is selected -- not a track or tracks -- and click the Burn icon in the top right corner of
iTunes. Burning will begin.

To Burn a Data CD

To create a data CD that can be read on either Macs or PCs:

1) Insert a blank CD. After a few moments, it will appear on the desktop.

2) If you like, rename the blank to something like "Audio Backup" (to rename a file or folder on the Mac,
click its name and then wait a moment -- the name will become editable). When the recipient of the CD
inserts it into their computer, this is the name with which the disc will appear in their Finder or Explorer.

3) Drag your files or folders onto the blank CD icon.

4) When done, drag the CD icon to the trash. The trash icon will turn into a "burn" icon. The Mac will ask if
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you actually want to burn the CD at maximum speed. Click Burn and burning will begin.

Note: Test your burned CD on both a PC and a Mac before mailing to others!

Note: These instructions also work for data DVDs, but you need Mac OS X 10.3 (Panther) to create a DVD
that will also work under Windows. If burned under 10.2, the DVD will be Mac-only.
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Converting files to MP3s in iTunes

Export your audio files1. 
Open iTunes2. 
In the iTunes toolbar, click on iTunes menu and select Preferences.3. 

4.Select the Advanced tab and select the Importing tab. In the Import Using section, select MP3 encoder.

In the Settings tab, choose Custom and a new dialog box will appear.1. 
Set the Stereo Bit Rate to 128k and set the Channel to Mono.2. 
Click OK on the Custom box and on the Preferences tab.3. 
Now go to your Playlist and import your audio file.4. 
CTL click on the audio file in iTunes. A menu will appear and select Convert Selection to MP3.5. 

10.The file as a MP3 will appear in the Music Library with the same name as your original file. You can
figure out which format the file is by clicking CMD(Apple)-I.

© The Regents of the University of California  
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